
Contents for MacroModel Help

Click an underlined topic or a tool on the tool palette.

File menu
Edit menu
View menu
Object menu
Render menu

Glossary
Keyboard shortcuts
About the tool palette

For an index to help topics, click the Search button at the top of the MacroModel Help window.

For more online help, choose the Status Bar command from the File menu -- instructions appear in the 
status bar at the bottom of the MacroModel window.



Glossary
Click a glossary term to see a definition:

alpha channel
anti-aliasing
arc
attitude
child
direct reflectance
display object
distant light
extruding
Gouraud shading
hidden wire
intensity
lathing
linking
local light
parent
polyline
position
rendering
roughness
shade
shaded wire
skinning
smooth
softness
specular highlight
surface
sweeping
wireframe
working plane
workspace
world



Keyboard shortcuts
You can use keyboard shortcuts to activate many commands and actions in MacroModel.

Click a category for more information:

File menu shortcuts
Edit menu shortcuts
View menu shortcuts
Object menu shortcuts
Render menu shortcuts

Tool modifier keys

Object-snapping keyboard modifiers



Tool modifier keys
Keyboard 
Shortcut Does This
F3 Arrow and hand tools: Rotates the object around the x and z axes of the screen by 

dragging

Control point tool: Deletes the control point

Zoom tool: Zooms out

Spline tool: Lets you set the tangent line for the next point by dragging

Twist, bend, taper, and stretch tools: Selects an anchor point about which to modify the 
object

Cross-section tool: Defines the axis for the cross section or front profile

F4 Arrow and hand tools: Rotates the object around the x and y axes of the screen by 
dragging



Object-snapping keyboard modifiers
Keyboard 
Shortcut Does This
2 Snaps to a location on the working plane

3 Snaps to a location in 3D space

h Constrains movement to the x-axis of the working plane

n Constrains movement along a line normal to the working plane

o Snaps to the origin

p Constrains movement perpendicular to geometry in the hit radius

s Disable snapping

t Constrains movement tangent to geometry in the hit radius

v Constrains movement to the y-axis of the working plane



File menu shortcuts
Command Shortcut
New Control-N
Open Control-O
Save Control-S
Exit Alt-F4



Edit menu shortcuts
Command Shortcut
Undo Control-Z
Undo Last Control-R
Redo Next Control-T
Cut Control-X
Copy Control-C
Paste Control-V
Clear Control-Delete
Duplicate Control-D
Select All Control -A
Model Browser Control-B
New Browser Item Control-K
Inspect Item Control-I
Find Control-F



View menu shortcuts
Command Shortcut
View Browser Control-E
Home Control-H



Object menu shortcuts
Command Shortcut
Object Browser Control-W
Join Control-J
Duplicate Link Control-5
Simplify Geometry Control-6
Show Working Plane Control-P
Working Plane to View Control-Y
Working Plane to World Control-U
Open Selected Control-7
Close Selected Control-8
Hide Selected Control-9
Show All Control-0



Render menu shortcuts
Command Shortcut
Final Render Control-G
Material Browser Control-M
Light Browser Control-L



alpha channel    An 8-bit channel used for storing opacity information. You can use this 
information for compositing images in an image-processing application.



anti-aliasing      Reducing or removing jagged edges or detail loss in an image by placing 
intermediate colors along the edges to give the appearance of smoothness.



arc    A segment of a circle.



attitude    The way an object is oriented, or rotated, in the MacroModel World.



child    An object that is linked to a parent object so that it inherits the position and attitude 
of the parent in the workspace.



direct reflectance    The brightness of a material -- the amount of light that the material 
reflects. This is controlled by the reflectance slider in the Material Browser. The higher the 
Reflectance value, the more light the object reflects.



display object    A reference object contained in each view. The display object and all its 
children are shown in the view. The display object can be changed by using the View 
Selected Only command on the View menu.



distant light    Like sunlight, a distant light shines in a definite direction from a source 
infinitely far away, illuminating all objects that face it.



extruding    Extending the outline of a two-dimensional object out into space on a plane 
perpendicular to the object's 2D profile. 



Gouraud shading    Or smooth shading -- a type of shading that makes a polygonal object 
appear smooth.



hidden wire    A rendering style in which the edges of an object are drawn as lines, and 
enclosed surfaces are hidden.



intensity    The brightness of a light source, controlled by the Intensity slider in the Light 
Browser. The higher the intensity value, the brighter the light.



lathing    Rotating an object's 2D outline around a defined axis.



linking    Combining individual objects into a complex hierarchy.



local light    Or point light -- a light that radiates uniformly in all directions, like a light bulb.



parent    An object that has one or more child objects linked to it in a hierarchy. The child 
inherits attributes from the parent.



polyline    A line made up of more than one line segment.



position    The location of an object as defined by the coordinates of the MacroModel World.



rendering    Applying a lifelike appearance to a model. 



roughness    The surface texture of a material, controlled by the Roughness slider in the 
Material Browser. A higher roughness value diffuses the highlight on the material, making 
the material look rough.



shade    A rendering style in a tone pattern is drawn on each polygon in the object. The 
object retains its polygonal appearance.



shaded wire    A rendering style in which the object is drawn with flat shading and with lines 
defining the object edges.



skinning    Stretching a surface over cross-sections of 2D shapes.



smooth    A rendering style in which the object surfaces are shaded to make the object 
appear smooth. This is the default rendering style. See Gouraud shading.



softness    Or ambience -- nondirectional light that is uniformly distributed on object surfaces,
controlled by the Softness slider in the Light Browser. The higher the softness value, the 
more diffuse the light that illuminates objects, and the softer the shadows cast by the 
objects.



specular highlight    The highlight on an object's surface, controlled by the Specular slider in 
the Light Browser. The higher the specular value, the brighter the highlight appears, making 
the object look shinier.



surface    Rendering surface-level options that render the object at low, medium, and high 
resolution. The higher the resolution, the more realistic the object looks. However, higher 
resolution requires more rendering time.



sweeping    Extending an object's 2D outline along an arbitrary path in space.



wireframe    A rendering style in which objects are drawn as lines only, without fill.



working plane    MacroModel's drawing surface, which can be oriented any direction in the 
MacroModel World.



workspace    The portion of the MacroModel World that is visible on the computer screen. 
This is the portion of the world in which models are created.



world    A volume of three-dimensional space that is virtually infinite in size.



File menu
Click a command to see information about it.

The File menu includes commands for creating, opening and closing, saving, and printing MacroModel 
models and for exporting and importing files to and from other applications. 

You can have up to four models open at a time.



New and Open commands
New 
Opens a new, untitled model in the MacroModel workspace window. Create a new model in this window 
by selecting one or more tools from the tool palette.

Open 
Opens an existing model. Open a model by double-clicking its name in the File Open dialog box or by 
selecting its name and clicking Open.

MacroModel models use the .MDL file extension.



Close, Save, and Save As commands
Close
Closes the model. If you close a model with unsaved changes, youre prompted to save. Choosing Close 
has the same effect as double-clicking the close box at the top left of the active windows title bar. If no 
other models are open when you choose Close, all open browsers are closed. If another model is open, it 
becomes the current model and the browsers are updated to display information about the model.

Save
Saves the current version of the active model. This replaces the previous version saved under the same 
name and allows you to continue working with the model. 

The first time you choose Save after creating a new model, the Save As dialog box opens so that you can
name the model and choose a location in which to save it. 

Save As
Allows you to save an untitled model, change the name of the current model, or save the model in a 
different disk or directory. 



Revert command
Reverts to the last saved version of the current model. MacroModel asks you to confirm this command, 
since unsaved changes will be lost. 



Import command
Imports a file type into a MacroModel model. The contents of the imported file are merged into the current
model. You can import information about 2D geometry, 3D geometry, or text, depending on the type of file 
you import. You cannot import information about lights or materials. The Import submenu allows you to 
choose one of the following file types:

- DXF -- a file format that can be read as AutoCad Drawing Exchange File (DXF) format and converted 
into text and 2D or 3D geometry. (To import text into MacroModel, select the Import Text checkbox in 
the Preferences dialog box.)

- Metafile -- A 2D image file format for Windows.

- EPSF -- (Encapsulated PostScript File) A 2D file format created by products like Adobe Illustrator.



Export command
You can export a MacroModel model as a DXF, Metafile, Bitmap, or RenderMan file. Metafile and Bitmap 
are 2D file formats. DXF and RenderMan are 3D file formats. 

Type the models filename in the File Name text box. Choose a file type from the Save File as Type drop-
down list. Use the Directories list and Drive drop-down list to choose the location of the exported file. 

Click either of the following topics for more information:

Saving models in 2D format

Saving models in 3D format



Saving models in 2D format
Metafile -- A model saved in metafile format is a collection of individual polygons or lines that you can 
edit. The polygons (or lines) keep the same order, back to front, that they had in the model. When you 
export models in metafile format, smooth shading, shadows, and anti-aliasing are not retained. However, 
modeling applications can re-create these attributes from the models polygons.

Bitmap -- A model saved in bitmap format is a bitmapped image of the MacroModel model. Bitmapped 
files do not retain information about individual objects from which the model was created. However, the 
bitmapped image retains the appearance of shadows, shading, and anti-aliasing.

Attributes exported with 2D file formats:
Attribute Metafile Bitmap
2D geometry Yes No
Colors Yes Yes
Shading Yes Yes
Shadows No Yes
Anti-aliasing No Yes



Saving models in 3D format
DXF and RenderMan are 3D formats.

Models saved in DXF format can be used in applications that use DXF files to perform CAD and 
rendering.

Models saved in RenderMan format can be used with RenderMan's photorealistic renderer. 

Attribute                 DXF           RenderMan  
2D geometry Yes No
3D geometry Yes Yes
Object hierarchy No No
Lights No Yes
Object names No No
Materials Yes Yes

Note: When you export a 3D object from MacroModel, you lose some 3D geometry information. 
Therefore, if you later reimport the model into MacroModel, the imported image is incomplete. See the 
Simplify Geometry command on the Object menu for more information about levels of geometry.



Print and Print Setup commands

Print
Prints the current view of the model. When you choose the Print command, the Print dialog box for the 
installed printer appears. The options in this dialog box vary according to the type of printer you have.

Using the Preferences command on the Edit menu, you can elect to print a model in Bitmap or Metafile 
format. See the Preferences command for more information about these options.

Print Setup
Opens the Print Setup dialog box for the installed printer.



Status Bar command
Use the Status Bar command to display and hide the status bar at the bottom of the MacroModel window.

The status bar gives you information about using MacroModel tools. When the cursor is over a tool in the 
tool palette, the status bar displays the name of the tool. When a tool is selected and the cursor is in the 
workspace, the status bar tells you how to use the tool. If there are several steps involved in using a tool, 
the status bar displays each tool in succession -- when you complete one action, the next is displayed.

For example, here is an illustration of the how the Status Bar appears when you use the Construction 
Point tool:



Exit command
Exits MacroModel and returns you to the Program Manager. If any of the currently open models have 
unsaved changes, you are prompted to save the changes or cancel the Exit command.



Edit menu
Click a command to see information about it.

The Edit menu contains commands for undoing and redoing operations in MacroModel and for handling 
Clipboard operations.

This menu also contains commands for opening the Model Browser, adding a new item to the current 
browser, and finding any item in the current model.



Undo, Redo, Undo Last, and Redo Next commands
Undo/Redo
Undoes the last action in the active window. When you choose the Undo command, the menu item 
changes to Redo.

File menu commands, such as opening or saving a file, are irreversible. When an action cannot be 
undone, you can revert to the last saved version of the file by using the Revert command on the File 
menu.

Undo Last
Allows you to undo up to five actions in the active window. If there are no more changes to undo, or if you 
haven't changed the current model, this command is dimmed.

Redo Next
Allows you to redo up to five actions in the active window. If there are no actions left to redo, the 
command is dimmed.



Cut and Copy commands
Cut
Removes the selection from the model and places a copy of it on the Clipboard. The Clipboard contents 
can then be pasted elsewhere. This command operates on selected geometry objects in the workspace 
and on selected items in the current browser.

Copy
Places a copy of the selection on the Clipboard. The copied selection can then be pasted elsewhere. This
command operates on selected geometry objects in the workspace and on selected items in the current 
browser.

Tip:    By creating a library of materials, lights, and views, you can copy commonly used items from the 
library into your models. To create a library, open a new MacroModel model and name it library. When you
create materials, lights, and views that you might want to use again, copy them into the library. When you 
want to use the item in another model, copy it from the library.



Paste command
Pastes the Clipboard contents into the active window. This command operates on selected geometry 
objects in the workspace and on selected items in the current browser. 

When a browser is active, Clipboard contents are pasted at the end of the selected parent object's list of
children. If you attempt to paste Clipboard contents into the inappropriate browser -- materials into a View 
Browser, for example -- MacroModel beeps and does not execute the command.

When the workspace is active, if one object is selected, the contents of the Clipboard replace the 
selected object. If multiple independent objects are selected (that is, the selected objects are not in a 
parent/child relationship), all selected objects are replaced by the contents of the Clipboard. If no object is
selected, the contents of the Clipboard are pasted into the world. 



Clear command
Removes the selection without copying it to the Clipboard. This command operates on selected geometry 
objects and on selected items in the current browser. If you accidentally clear a selection, reverse the 
action with the Undo command.



Duplicate command
Duplicates the current selection. This command operates on selected geometry objects and on selected 
items in the current browser.

If a browser is selected, a duplicate object is made and placed in the same position as the original. If the
default ruler unit (inches) is in effect, the duplicate objects are offset from the original by 1 inch. All link 
and attribute information is preserved. For each duplicated object, a lowercase letter "i" is added to the 
end of the object's name in the active browser's object list.



Select All command
Selects all the geometry objects in the current model window.



Model Browser command
Opens the Model Browser, which shows the hierarchy of objects in the selected model and allows you to 
rename objects or to edit their hierarchies. (Click to see an illustration: Model Browser.)

The name of the parent object is displayed at the top of the Model Browser. Below the parent object are 
listed the children that are attached to the parent.

Clicking the name of an object selects it. When an object is selected, you can edit its name by typing a 
new name in the text field at the bottom of the browser and pressing Enter. 

You can add to a parent's list of children by pasting an object from the Clipboard. 

You can cut, copy, duplicate, and clear objects in the child list and drag an object to change its position 
in the list. Double-clicking the name of the parent object displays its parent at the top of the Model 
Browser. Double-clicking the name of a child object in the list moves that object to the top of the hierarchy.
If an object has no children, nothing is listed.



 



New Browser Item command
Creates a new default child item in the current browser. 

Using the New Browser Item command when the View Browser is open does the same as using the New 
View command on the View menu; using the New Material command on the Render menu; or using the 
New Distant Light command on the Render menu. 

When the Object Browser is active, the New Browser Item command creates an axis half the size of the 
construction axis. The new object acts as a placeholder or an orientation reference for the existing object. 

This command is dimmed if the workspace is active.



Inspect Item command
This command opens the browser, selects the item, and displays all information for that item. For 
example, when you select a light in the Model Browser and choose Inspect Item, the Light Browser opens
with the selected light highlighted.



Find command
Opens the Find dialog box, in which you can search by name for any object -- including geometry, lights, 
materials, and views--in the current model.

Click a part of the following illustration for more information:

Tip: It's a good idea to use a consistent convention for naming objects. For example, you might name a 
selection of chair styles Chair 1, Chair 2, and so on. You could then use the Find command with the Add 
to Selection option to select all your chair models at one time.



Type the text (or partial text) you want to locate in the text field of the dialog box.



In the Find text box, enter the partial or whole name of the item you're searching for. If you're searching 
for the whole name, click the Use Whole Name checkbox. When you click Find, MacroModel searches all
the objects in the model including views, materials, and so on. When it finds the named object, it opens 
the appropriate browser with the found object selected. 



To search for geometry objects only (including local lights), click the Add to Selection checkbox. When 
this box is checked, MacroModel selects all the objects that match the text in the Find text box and adds 
the objects to the current selection.



Click the Find button to search for the desired text.



Preferences command
Opens the Preferences dialog box. Click a part of the illustration for more information:



In the Printer/Clipboard Output group, you can choose to have a model sent to the printer or to the 
Clipboard in bitmap or metafile format. Bitmap format sends the file as a bitmapped image of the scene or
objects. Metafile format sends the file as a list of sorted polygons.



The Files group contains three options for importing images into MacroModel.

- Click the Import Text checkbox if you want to import text into MacroModel from a DXF, 
EPSF, or metafile file. 

- Click the DXF Layers to Hierarchy checkbox to preserve some of the information about
the model's links when importing or exporting a model in DXF format. When files are 
exported, the DXF Layers to Hierarchy option treats each root parent object and its 
children as a separate layer. When files are imported, the DXF Layers to Hierarchy option
creates a new point for each layer. MacroModel links all objects in that layer to the point 
and names the new point after the layer.

- Click the Save Compact Files checkbox to compress the file when it is exported. Only 
MacroModel can read a compact MacroModel file. Compact MacroModel files cannot be 
read by other applications that read normal MacroModel files. 



The Geometry group contains options that let you apply caps to surfaces and reorient the working plane 
after it is moved: 

- Click the Cap Ends checkbox to create front and back caps automatically on all closed 
3D objects. 

- Click the Auto Working Plane to View checkbox to have the working plane always 
shift to face you directly whenever you change the view. For example, if you change the 
view from the front to the right, the working plane automatically rotates to the right so 
that it is parallel to your new view. To set the working plane to the current view without 
changing when the view changes, leave this checkbox unselected and choose Working 
Plane to View from the Object menu.

- The Nudge Position, Nudge Angle, and Nudge Scale fields set the increments for 
how much a model moves when it is nudged. The Nudge Position setting has the same 
units as the setting in the Rulers dialog box. The Nudge Angle setting is in degrees. The 
Nudge Scale setting has the same units as the setting in the Rulers dialog box.



View menu
Click a command to see information about it.

This menu contains commands for modifying the way you view objects in MacroModel. 

Commands on this menu do not modify objects; they only change the way you view them.



New View command
Creates a new view. 

Choosing New Browser Item when the View Browser is active also creates a new default view.

Click an attribute name to see its default value and to see instructions on changing its value:

Position
Attitude
Scale
Perspective
Render style
Display object

Related topics:
View Selected Only command
New Browser Item 



Position
Default value To change the value
x=0, y=0, z=0 Type values in the View Browser.

Use the hand tool.
Use the zoom tool.



Attitude
Default value        To change the value  
yaw=0°,    Type values in the View Browser.
pitch=0°, Use the F3 or F4 key with the hand tool.
roll=0° Use the Orient command on the View menu.

Use the Orient View to Object command on the Object menu.



Scale
Default value To change the value
1.0 (100%) Type values in the View Browser.

Use the Size to Fit command on the View menu.
Use the zoom tool.
Use the F2 key with the hand tool.



Perspective
Default value To change the value
Narrow Use the Perspective command on the View menu.

Use the zoom tool.



Render style
Default value To change the value
Smooth Use the Render Style command on the Render menu.



Display object
Default value To change the value
World Use the Views command on the View menu and select the object you want to view.



View Browser command
Opens the View Browser.

Click part of the illustration of the View Browser to see more information. You may need to expand the 
MacroModel Help window to see the entire illustration.

When you select a view, it becomes current so that you can see changes in the workspace as you make 
them. 

One default view -- a front view -- comes with MacroModel. If you wish, you can create your own default 
file, consisting of materials, lights, and views that you've created. When you save this default model as 
DEFAULT.MDL in the Scripts folder, the program will automatically read the file's contents into any new, 
untitled model that you create.



The Views list at the left side of the browser shows all the views available for the current model. By 
selecting a view name from the list, you can choose the view that you want to edit. By typing a new name 
in the view name field at the bottom of the browser, you can change the name of the view.



The numbers in the Position fields show the center of the view, the point that you're looking at in the 
view. From top to bottom, the x, y, and z coordinates describe a point in absolute, or world, space. When 
the view is rotated or scaled, it is rotated or scaled around this point. When you type a number in the 
numeric field and press Enter or Return, the view is immediately redrawn using that value. 



The numbers in the Attitude fields show the model's rotation around the center of the view. These 
numbers are expressed as degrees. When you type a number in the numeric field and press Enter or 
Return, the view is immediately redrawn using that value. 

To manually change the attitude of the view, use the trackball at the right side of the View Browser. Click 
and drag the x, y, or z face of the trackball cube to rotate the trackball. When you use the trackball, a 
simplified image of the view is redrawn in the workspace as fast as your processor allows.



The drop-down list at the bottom of the View Browser indicates how position and attitude changes are to 
be applied to the view. Absolute is the default. When this option is selected, MacroModel resets the view 
to the exact values that you type in the numeric fields. When you choose Delta Change from the drop-
down list, you can type in the difference between the current setting and the final setting that you want. 



The Scale field shows the scale of the view, expressed as a decimal -- 1.0 equals 100%. For example, at 
2.0 the objects appear twice as large on the screen. To change the scale of the model, edit the numbers 
in this field and press Return or Enter to apply the new value; press Tab to apply the new values and 
advance to the next field. The center of the view always remains the same. 



When a view is locked, you cannot change its attributes without first unlocking it.



You can manually change the attitude of the view using the trackball at the right side of the View Browser. 
Click and drag the x, y, or z face of the trackball cube to rotate the trackball. When you use the trackball, a
simplified image of the view is redrawn in the workspace as fast as your processor allows.



Perspective submenu
The commands on the Perspective submenu determine the view distance -- the distance between the 
viewer's eye and the center of the MacroModel view. By default, view distance units are in inches. You 
can change the default units using the Rulers command on the Object menu.

Choose an option from the Perspective submenu to alter the view distance, and therefore the 
appearance, of objects. Their position and attitude remain unchanged.

Perspective                View distance (inches)  
Orthographic 139 or very far
Narrow (default) 13.9
Moderate 6.9
Wide 4.2
Very Wide 2.1
Custom The value you set

The Custom item on the Perspective submenu opens a dialog box in which you can define a custom 
perspective for the model. By entering a number in the View Distance field, you establish the distance 
between the viewer's eye and the center of the view. You cannot set a custom perspective with a view 
distance of less than 0.7 inches.



Orient submenu
The commands on the Orient submenu determine the side from which you view the model. The 
commands on this menu reset the view settings to the following angles:

Orientation                 Shows  
Top Top of model at 90, 0, 0 orientation

Front Front of model at 0, 0, 0 orientation

Axonometric Front, top, and side of model at 30, 30, 0 orientation

Right Right side of model at 0, 90, 0 orientation

Bottom Bottom of model at 90, 0, 0 orientation

Back Back of model at 0, 180, 0 orientation

Left Left side of model at 0, 90, 0 orientation

To Working Plane Sets the orientation to that of the working plane



Home command
Reapplies the default settings to the current view: position 0, 0, 0; attitude 0, 0, 0; scale 1.0; offset to the 
center of the world; narrow perspective; smooth rendering style.



Fit to Window command
Changes the position and view so that all objects are visible in the workspace. 

Operates on visible objects only. If you've made an object invisible using the Hide Selected command on 
the Object menu, that object remains invisible.



View Selected Only command
Hides all objects except the selected object and its children. This command resets the display object to 
the currently selected object and its children.    

This command does not change the viewing angle or position, just which objects are visible. To change 
the display object selection, click the background of the view to select the world, then again choose View 
Selected Only. 

Tip: Use View Selected Only to display a selection of objects, then choose New View to create a view 
containing only those objects. In this way, you can create layers of objects that can be manipulated one 
layer at a time.



Object menu

Click a command to see information about it.

This menu contains commands for manipulating objects and the working plane in MacroModel. 



Object Browser command
Opens the Object Browser, in which you can select and edit single and multiple objects, their defining 
geometry, and selected vertexes.

Click part of the illustration of the Object Browser to see more information. You may need to expand the 
MacroModel Help window to see the entire illustration.

If you open an object and select some of its vertexes, changes you make to position, attitude, and scale 
will apply to the selected vertexes.



The Objects list at the left side of the browser shows the objects in the current model. When you select an
object from the list, you select it for editing. When you double-click an object in the list, it becomes the 
parent object and is opened for editing. 

By typing a new name in the text field at the bottom of the browser, you can change the name of the 
selected object.



The numbers in the Position fields show, from top to bottom, the x, y, and z coordinates of the object. To 
change the objects position, edit the numbers in these fields and press Return or Enter to apply the new 
values; press Tab to apply the new values and advance to the next field. 

To lock the x, y, or z position coordinate for an object, click the checkbox next to the numeric field. When 
this checkbox is selected, the corresponding coordinate cannot be moved in the workspace.



The numbers in the Attitude fields show the objects rotation around the x, y, and z axes, from top to 
bottom. These numbers are expressed as degrees. To change the objects rotation, edit the numbers in 
these fields and press Return or Enter to apply the new values; press Tab to apply the new values and 
advance to the next field. To lock the x, y, or z attitude coordinate for an object, click the checkbox next to 
the numeric field. When this checkbox is selected, the corresponding coordinate cannot be rotated in the 
workspace.



The drop-down list in the Object Browser controls how position and attitude changes are applied to the 
object. Choose Relative to change the position or attitude of the selected object relative to its parent 
object. Choose Absolute to change the position or attitude of the selected object relative to the view. 
Choose Delta Change to enter the difference between the current position or attitude and the position or 
attitude you want.



Using the attitude trackball, you can manually change the rotation of the object. Click and drag the x, y, or 
z face of the trackball cube to rotate the trackball and the model in the selected view. In the workspace, a 
simplified image of the last selected object reflects the changes you make using the trackball. 



The Scale field shows the scale of the object, expressed as a decimal. To change the scale of the object, 
edit the numbers in this field and press Return or Enter to apply the new value; press Tab to apply the 
new value and advance to the next field. To lock an objects scale, select the checkbox next to the numeric
field. When this checkbox is selected, the scale cannot be changed in the workspace.



Rulers command
Opens the Rulers dialog box, in which you set the units displayed in the Object Browser, the View 
Browser, and wherever else measurements are displayed in MacroModel. 

Click part of the illustration to see more information. You may need to expand the MacroModel Help 
window to see the entire illustration.

The default unit is inches.



The top Model Scale ruler shows the units used on the screen. By selecting an option from the drop-
down list next to the Model Scale ruler, you can choose to draw models in inches, feet, millimeters, or 
centimeters. 



The bottom Ruler Scale ruler sets the ratio between the models size as it appears in the view and the 
size the model would be in the real world. Units chosen for the Ruler Scale ruler do not affect how the 
model appears on the screen.    



The Divisions numeric field at the bottom of the dialog box sets the number of subdivisions used in the 
ruler scale and working plane. For example, to divide 1 foot into 1-inch increments, enter the number 12 
in the divisions field. To divide 1 foot into 6-inch increments, enter the number 2 in this field.



Orient to View Object submenu
The commands on the Orient to View Object submenu determine the angle from which you view the 
object. When you choose a command from the submenu, the view changes so that you view objects from 
a different angle.

Orientation          Shows  
Front Front of object at 0, 0, 0 orientation
Back Back of object at 0, 180, 0 orientation
Right Right side of object at 0, 90, 0 orientation
Left Left side of object at 0, 90, 0 orientation
Top Top of object at 90, 0, 0 orientation
Bottom Bottom of object at 90, 0, 0 orientation



Align submenu
The commands on the Align submenu control the position and attitude of a selected object in relation to 
its parent. If the selected object does not have a parent, it is aligned with the center of the world.

Align All aligns both the position and attitude of the object with the origin of its parent. 

Position aligns the origin of the selected object with the origin of its parent. 

Attitude aligns the selected object so that it has the same orientation as its parent.

When an object is open for editing, its origin is displayed as a small square. You can set the origin of an 
object using the object center tool in the tool palette. 



Join command
Joins open and connected 2D objects into a single object. To create a joined shape, select two or more 
contiguous open 2D shapes (such as lines, arcs, and open polyline shapes) and choose Join from the 
Object menu. When the objects are joined, you can edit the objects shape by moving its control points.

The Join command turns connected 2D objects into a single shape.



Smooth command
Smooths objects created with the polyline tool by turning them into spline objects and rounding all their 
edges.

Tip: You can smooth the corners of a rectangle by converting the rectangle into polylines. First use the 
Simplify Geometry command, then choose Smooth.



Duplicate Link command
Duplicates the selected object (and its children) and makes the duplicate object a child of the original 
object. The duplicate object retains the position, attitude, scale, and other attributes of the original object. 
Since the Duplicate Link command re-creates the relative position between the two objects, this 
command is useful for creating a geometrically repeating form such as a spiral staircase.



Simplify Geometry command
Changes the level at which you can edit the object. There are three editing levels -- click one for more 
information: 

Compound 3D geometry
Surface geometry
Poly Mesh/Poly List

When you select an object and choose Simplify Geometry, MacroModel removes the highest level of 
geometry from the object. When you open the object for editing, it displays the highest level of geometry 
that it retains. For example, if you simplify the geometry of a sphere by removing its compound 3D 
geometry, the sphere will display its surface geometry when you open it for editing.

Note: MacroModel cannot re-create a higher level of geometry after that information is removed. Only the
Undo command can return to the higher level of an object once it is simplified. However, you can undo 
only five operations in a series.    



The first level, Compound 3D geometry, consists of an objects 2D and 3D geometry 
components. You edit the object at this level by adjusting the underlying 2D geometry or the
3D geometry that you applied to the object.



The second level, Surface geometry, is a series of surfaces defined as spline curves. You 
adjust the form of the object by dragging control points (much as you modify curves in an 
illustration program, but in three dimensions).



The third level, Poly Mesh/Poly List, consists of a matrix of polygons. You adjust the form 
of the object by dragging vertexes on the object's surface. This type of editing gives you 
maximum control over an objects shape, but results in loss of data. A poly list is generated 
when an object with holes in it is simplified. Similar to a mesh, a poly list is a matrix of 
polygons.



Show Working Plane, Working Plane to View, 
and Working Plane to World commands
Show Working Plane 
Toggles the visibility of the working plane in the workplace.

Working Plane to View
Orients the working plane flat to the screen.

If you want to lock the working plane to the settings of the active view, select the Auto Working Plane to 
View checkbox in the Preferences dialog box.

Working Plane to World
Sets the working plane parallel to the world orientation. The working plane is set to the world axes that 
most nearly face the current view.



Open Selected and Close Selected commands
Open Selected
Opens all selected objects so that they can be edited.

Close Selected
Closes all selected objects.



Hide Selected and Show All commands
Hide Selected
Hides the selected objects.

Show All
Shows all objects in the model.



Hide Construction Objects and Clear Construction Objects commands
Hide Construction Objects
Hides construction lines, points, axes, and grids for the model. Hiding a models construction geometry 
simplifies the appearance of the scene. 

When you choose Final Render from the Render menu, construction objects and the working plane are 
automatically hidden and the Hide Construction Objects command in the Object menu is checked to show
that it has been activated.

Clear Construction Objects
Deletes construction lines, points, axes, and grids for the model. When the construction object is the 
parent of a geometry object, the construction object is not removed.



Render menu
Click a command to see information about it.

The Render menu contains commands that control how the model is rendered, including options for 
lights, material, surface, and rendering style.



Render Set-Up command
Opens the Render Set-Up dialog box. Click part of the illustration to see more information.



The Renderer Type drop-down list lists the available renderers. 
The 8-bit ZBuffer renderer uses 236 of 256 possible colors. This renderer does not support colored 
lights; they are drawn as white lights when rendered in 8 bits. This renderer uses less memory than the 
24-bit ZBuffer renderer. Use it for general work, for animations, and for grayscale images for which you 
don't need 24-bit color resolution. If your model uses many materials, you'll see banding around the 
specular highlights when you're using Smooth Shading as the render style. 

The 24-bit ZBuffer renderer supports 24-bit color. Colored lights set in the Light Browser are visible 
when rendered with this renderer. Specular reflections on objects and shading are rendered more 
accurately than with the 8-bit renderer. You can only select the 24-bit ZBuffer if your display card and 
driver support 15 bits or more of color per pixel.



The Renderer Size drop-down list contains options for setting the screen dimensions, in pixels, of the 
renderer's workspace. The default size is 512 by 342. To set the render size, make a selection from the 
drop-down list and click OK. If there is not enough memory to set the selected renderer size, MacroModel 
beeps and reverts to the previous size setting.

The Custom Renderer Size option opens a dialog box that allows you to set a custom renderer size. The
size is in pixels, and it must be a multiple of 4. If it is not, MacroModel rounds up to the nearest multiple of
4.



The Final Rendering options in the Render Set-Up dialog box allow you to define how shadows and 
edges are rendered, whether to use high resolution for the final render, and how anti-aliasing is applied to 
the image. 

When Shadows is selected, the final rendering is shadowed from each light source listed in the Light 
Browser.

When Object Edges is selected, lines appear around the edges of objects in the final rendering, 
accentuating their intersections.

When the Surface High is selected, the final render uses the resolution set in the Final Render settings of
the Adaptive Smoothing or Regular Smoothing dialog box. 



The four Anti-Aliasing options increase the sharpness of the final image; however, each increase in 
anti-aliasing level increases rendering time by a factor of roughly four. The following table lists the number
of samples for each anti-aliasing level.

Level of anti-aliasing             Number of samples  
None 1
Low 4
Medium 9
High 16

Tip: If you are rendering a final image and want to accentuate the softness of the lights defined in the 
Light Browser, choose the Medium or High anti-aliasing option.



Final Render command
Renders the current model using the options selected in the Render Set-Up dialog box.

Large renders require a lot of memory and may take a long time to complete. Stop rendering at any time 
by pressing and holding F11.



Set Background command
Opens a dialog box that allows you to choose a background color or image for the model. Click part of the
illustration to see more information.



The Color swatch shows the current background color. Double-click it to open the Windows color palette 
dialog box. 



The Picture option allows you to set an image as a background for the model. Click Open to see an Open
File dialog box, in which you can choose the image you want to use. The image must be in Windows 
Device Independent Bitmap (DIB) format (8- or 24-bit).



When the All Views checkbox is selected, the options you choose in the Set Background dialog box will 
apply to all views of the model.



New Material command
Creates a new material, adds it to the material list in the browser, and makes the new material current. 
When a new material is created, it is plastic by default. To edit the new material, click its name in the 
Model Browser. This opens the Material Browser, in which you can change the attributes of the material. 
Once the material has been defined, you can apply it to models.



Material Browser command

Opens the Material Browser, in which you can create, select, edit, and delete new materials. 

Click part of the illustration to see more information.

The attributes that you can edit vary depending on the specific material. The default material is Plastic.

Changes are not visible in the workspace until you click the Update button.



A preview image of the current material appears in the image pane at the top of the Material Browser. As 
you change the material's attributes, the changes are immediately reflected in the image pane.



The color swatch shows the current material's color. To change the material color, double-click the Color 
swatch. This opens the Windows Color Palette dialog box, in which you can select a new color.



The Direct Reflectance slider in the Material Browser controls the brightness of the current material -- 
the amount of light that the material directly reflects. When the value in the numeric field to the right of the
slider is 0.0, the material is black and reflects no light. When the value is 1.0, the material reflects 
maximum light and appears the full color set in the Color swatch. You can change the light that a material 
reflects by dragging and clicking the slider or by entering a value in the field to the right of the slider.



The Specular Reflectance slider controls the brightness of the specular highlight the material reflects. 
The brighter the highlight, the shinier the material appears to be. For example, the specular highlight on a 
chrome globe is much brighter than the specular highlight on an orange. When the value in the numeric 
field is 1.0, the material reflects the brightest highlight. Change the brightness of the specular highlight by 
dragging and clicking the slider or by entering a value in the field to the right of the slider.



The Roughness slider gives the material a surface relief to make the material look sandblasted or 
frosted. Increasing the value in the Roughness slider spreads out the highlight on the material, making it 
look rougher. Decreasing the roughness value decreases the size of the highlight, which makes the 
material look shinier. A roughness setting of 0.0 produces a mirrorlike material. Change the brightness of 
the specular highlight by dragging the slider or by entering a value in the field to the right of the slider.



The scrolling list below the sliders in the Material Browser allows you to select a RenderMan shader to be 
used with the material.



The Materials list at the bottom of the browser shows the available materials in the current model. By 
choosing a material from the list, you select it for editing and apply that material to objects in the 
workspace. By typing a new name in the field below the materials list, you can change the name of the 
material selected.



New Local Light and New Distant Light commands
New Distant Light command
Creates a new distant light in the view, selects the new light as the current light, and redraws the scene 
using the new light. By default, this is a white light at 90% brightness. It points toward the center of the 
view from the current viewer position. 

A distant light is similar to sunlight. It shines in a definite direction from a source that is infinitely far away. 
Any object surface facing the distant light is illuminated by it. The object is always lighted with the same 
intensity, regardless of the object's position or distance from the light.

New Local Light command
Creates a new local light in the scene, selects the new light as the current light, and redraws the scene 
using the new light. By default, this is a white light at 90% brightness. It's positioned in the center of the 
view. The new local light is listed in the Light Browser and in the Object Browser.



Light Browser command 

Opens the Light Browser in which you can edit the lights in the current model.

Click part of the illustration to see more information.

When you've set the light attributes that you want, click the Update button to redraw the model in the 
workspace using the newly defined light. 



The Lights list at the bottom of the browser shows the available lights in the current model. By choosing a 
light from the list, you select it for editing. 
By typing a new name in the field below the Lights list at the bottom of the browser, you can change the 
name of the selected light.



At the top of the Light Browser is the light attitude trackball. You can edit the attitude -- the angle at 
which the light is shining -- of the current light by clicking and dragging the joystick inside the attitude 
trackball. As you move the joystick, the numbers in the attitude fields are updated. These numbers are 
expressed as degrees. You can also change the attitude of the current light by editing the numbers in the 
attitude fields.



The Color swatch shows the color of the current light. To change the light color, double-click the Color 
swatch. This opens the Color Selector dialog box, in which you can select a new color.



The Intensity slider controls the brightness of the light; 0 is the dimmest light and 1.0 is the brightest. You
can change the intensity of a light by dragging the slider or by typing a value in the numeric field.



The Softness slider controls the softness of a light by varying its diffusion. At a softness value of 0, the 
model is illuminated by a focused point of light that creates sharp shadows. At a softness setting of 1.0, 
the model is illuminated by diffused light that casts soft shadows. Change the softness of the light by 
dragging the slider, or by typing a value in the numeric field. The effect of changing the softness setting is 
visible only in the final render. 

To make the softness of the light more apparent, choose shadows and a higher anti-aliasing option in the 
Render Set-Up dialog box.



Render Style submenu
The commands on the Render Style submenu allow you to choose the render style that MacroModel uses
to draw the model. These commands change the render style setting of the current view.

- Wireframe draws lines for all front-facing polygons that make up the object. The 
wireframe render style reveals the internal structure of the object.

- Hidden Wire draws lines only for the front surface polygons of an object. All other 
construction lines are hidden. 

- Shade draws a tone pattern on each polygon of the object, depending on the material 
properties of the object and the lighting.

- Shaded Wire draws a combination of the Hidden Line and Shade render styles. Lines 
clearly delineate the object's front surface polygons, and shading shows the effect of the 
lights.

- Smooth draws objects with smooth tonal gradations between polygons. Reflected 
highlights are drawn using Gouraud shading.



Surface Smoothness submenu
The Surface Smoothness submenu lets you set how surface faceting and smoothing are done on the 
model.

Click a surface smoothness type for more information:

Adaptive Smoothness
Surface Subdivisions



Used to set the amount of smoothing applied to surface facets. If an object is selected, changes apply 
only to the selected object; otherwise changes apply to subsequently created objects.

The slider at the top of the dialog box sets the amount of smoothing on a scale from 0 to 1.0. The value 0 
gives the clearest display of individual polygons that make up the object. 1 gives the smoothest 
representation of the surface. 

Final render settings applies the resolution specified on the slider when the final object is rendered. 

Interactive render settings applies the resolution specified on the slider during model creation.

Use Surface Normals derives normals from the actual surface rather than the polygon mesh when 
rendering is performed.



Used to set the number of subdivisions between control points during rendering. If an object is selected, 
changes apply only to the selected object; otherwise, changes apply to subsequently created objects.

The Column Subdivisions field sets the number of column subdivisions used for faceting objects. 

The Row Subdivisions field sets the number of row subdivisions used for faceting objects. 

Final render settings applies the resolution specified on the slider when the final object is rendered. 
Click the Interactive render settings radio button to apply the resolution specified on the slider during 
model creation.

Use Surface Normals derives normals from the actual surface rather than from the polygon mesh when 
rendering is performed.



Tool palette
The MacroModel tool palette contains tools you can use to create and modify 2D and 3D 
objects. You select a tool by clicking its icon in the tool palette.
Tools with a notch in the lower right corner represent a group of tools that perform related 
functions. When you select a notched tool by clicking its icon, the tool group pops out. 
When you select the tool that you want to use from the tool group, that tool becomes the 
one that's displayed in the tool palette. 
The tool palette's default tool automatically becomes the selected tool again after you 
finish using any tool. To make a tool the default tool, press the F3 key and click the tool.
Several tools have dialog boxes that you can use to set preferences for how the tool 
operates. Open the dialog box by double-clicking the tool. 
Related topic: Tool space



Tool space
When you select a tool from the tool palette, the tool space at the bottom of the workspace 
displays numerical data for the tool. If you have not used the tool previously during the 
current session, MacroModel displays default values in the tool space. 
The information displayed in the tool space depends on which tool is selected. For details, 
see the "Tool space" heading in the help screen for the specific tool.
In addition to drawing an object in the workspace, you can define an object by typing values 
in the editable fields in the tool space and pressing the Enter key. When you press the Enter 
key without modifying the values in the tool space, MacroModel applies the values you 
specified the last time you used the tool. 
When the tool space is active and can be edited, it is outlined in red. Move between editable 
fields in the tool space by pressing the Tab key.



Arrow tool
This tool selects, opens, edits, and moves objects. 
Tool space: When the arrow tool is selected, the tool space shows the tool's x, y, and z 
coordinates in the workspace.
When the arrow tool is not over an object in the workspace, the tool space coordinates 
reflect world space with its origin (0,0,0 point) in the default view. Positive x direction is 
right; positive y direction is up. Units shown are those selected in the Rulers dialog box. As 
the arrow tool moves over control points of 3D objects, the tool space shows the coordinates
of the 3D geometry that the tool will snap to at that point. 
Click a topic for more information:
Arrow tool preferences

Selecting objects
Opening and editing objects 
Moving objects
Rotating objects
Nudging objects
Scaling objects



Selecting objects 
To select an object, click it with the arrow tool. To add objects to the selection, shift-click 
them. To deselect an object that is selected, shift-click it. An object may not be shift-selected
if its parent object is selected. 
To select multiple objects, draw a selection rectangle around them. All the objects enclosed 
by the rectangle are selected. 
Selecting an object that is included in a multiple selection deselects everything.
A selected 2D contour is displayed in red. A selected 3D surface is framed in a red bounding 
box -- the smallest 3D rectangular solid that encloses all points on the object.



Opening and editing objects 
To be edited -- that is, to have its shape changed -- an object must be open. To open an 
object, double-click it with the arrow tool.
When it is open, the object displays its defining geometry -- direction lines, direction points, 
and control point. 
To close an object that is already open, double-click it with the arrow tool. A closed object 
can be moved, scaled, and rotated, but cannot have its shape edited.



Arrow tool preferences

Options in this dialog box allow you to select the planes within which you can drag the 
direction lines of 3D surfaces. 
When Surface Tangents is selected, the points move in the plane defined by the point 
being moved and the line normal to the surface. This is useful when you want to edit an 
irregular point on an object -- if you want to edit the bump and not the log, for example.
When Bounding Box to View is selected, the control points and direction lines move in the
plane of the object's bounding box side that is most nearly aligned to the view. This option is
the default, and is suitable in most cases. 
When Working Plane is selected, the points move within the same plane as the working 
plane. 



Moving objects 
When you drag selected objects, MacroModel moves them parallel to the current working 
plane and indicates where they are being moved. 
Modifier key: To snap the object to other 3D geometry in the workspace, press the 3 key 
while dragging. 



Rotating objects 
Use the arrow tool to rotate an object around its center. You can change the center of the 
object using the object center tool. 
To rotate an object in the workspace, select the object with the arrow tool and drag it in the 
desired direction while pressing a modifier key.
Modifier keys: To rotate the object around the x and y axes of the screen, press the F4 key 
while dragging. To rotate the object around the x and z axes of the screen, press the F3 key 
while dragging. 



Nudging objects
Use the arrow keys on the keyboard to nudge objects -- move and rotate them by small 
increments. To nudge an object, select the hot key field in the tool space and press an arrow 
key. The name of the selected key appears in the hot key space.
When nudging is active and you move or rotate the object by clicking an arrow key, the 
object moves in small increments. To set increments for nudging, use the Preferences 
command on the Edit Menu. 
The units in the Nudge Position field of the Preferences dialog box are set in the Rulers dialog
box. Units for Nudge Angle (orientation) are degrees, and units for Nudge Scale are the same
as in the object browser. 



Scaling objects
Use the arrow tool and the F2 key to scale objects. When an object is scaled, it increases or 
decreases around the object's center point. To scale an object, press the F2 key while you 
click and drag anywhere on the object.



Hand tool group 
The tools in this group allow you to change position relative to the objects displayed on the 
screen. The hand tool performs several functions; the rotation tools constrain rotation to a 
particular axis of the workspace. As you use these tools to change the view, objects that are 
visible in the view are redrawn.
Click a tool to see more information about it.



Hand tool
Use this tool to move the view's position along the screen. Modifier keys let you rotate the 
view using this tool. How this movement affects the x, y, and z coordinates depends on the 
orientation of the view.
To move the view, drag with the hand tool in the workspace. As you drag, the bounding 
boxes of the visible objects move. 
Modifier key: To rotate the view around the x and y screen axes, press the F4 key as you 
click and drag. To rotate the view around the x and z screen axes, press the F3 key as you 
click and drag.



x, y, and z rotation tools
Use these tools to rotate the current view along its x, y, or z axis to rotate around that axis 
only, without changing the rotation around the other axes.



Control point tool
Use this tool to add control points to and subtract them from existing objects. 
To add a control point to an object, double-click the object with the arrow tool to open it for 
editing and display its defining geometry. With the control point tool, click a place on the 
object where there is no control point. A new control point appears where you clicked. This 
control point can be selected and dragged like any other control point. 
Modifier key: To delete a control point, press the F3 key while clicking an existing control 
point.



Link tool group
The tools in this group allow you to create hierarchical relationships among objects and to 
edit the object hierarchy. By linking individual objects together, you can simulate the 
movement of complex mechanical and physiological objects. By establishing hierarchical 
relationships among objects, you can make changes in one part of the hierarchical structure 
that affect other objects in the structure.
Click a tool to see information about it.

When you link two objects together, one object becomes the parent and the other becomes 
the child. The child object moves and rotates as the parent object does. For example, when 
you link a wheel (the child) to a bicycle (the parent), the wheel moves through space when 
the bicycle does. 
By default, all objects have the world as their parent. Using the different link tools, you can 
define a new parent for an object, and specify how freely the child rotates and moves in 
relation to the parent. 



Free link tool
When two object are linked with a free link, the child object can be moved and rotated 
independently from its parent. When the parent is moved, however, the child moves with it.
To create a free link, click the child object with the free link tool and drag a line to its parent.



Unlink tool
Use this tool to separate linked objects. When you break a link, the object reverts to the 
default parent, the world.
To break a link, click the child object that you want to unlink with the unlink tool.



Ball-joint link tool
Use this tool to create a link in which the child object can rotate on all axes, but only moves 
as its parent moves.
To create a ball-joint link, click the child object with the ball-joint link tool and drag a line to 
its new parent.



Lock link tool
Use this tool to create links in which the child object can only move and rotate as its parent 
moves and rotates. 
To create a lock link, click the child object with the lock link tool and drag a line to its parent.



Placement tool group
Tools in this group allow you to precisely rotate and translate an object.
Click a tool to see information about it.



Rotate axis tool
Use this tool to rotate an object around an axis in 3D space. Follow this sequence:
To define the axis starting point, click once in the workspace to define the.
To define a reference point, click a point on the object that you want to rotate.
To rotate the object, drag the object around the defined axis. The object rotates so that 
the reference point lies on a plane between the axis and the current mouse location.



Rotate point tool
Use this tool to rotate an object around a specified point. Follow this sequence:
To define the center of rotation, click once in the workspace to define the point around 
which the object will rotate.
To define a reference point, click a point on the object that you want to rotate.
To rotate the object, drag the object around the center of rotation. The reference point on 
the object rotates around a line between the center of rotation and the current mouse 
location.



Placement tool
Use this tool to precisely place an object in relation to another object. Follow this sequence:
To snap the moving object to a stationary object, click to define a point on the object 
and drag to move the object and snap it to another object.
To define a reference point, click to define a point on the object and drag to move the 
object and snap it to another object.
To rotate the object, click to define a third point on the moving object and drag to rotate 
the object around the axis defined by the two "stuck" points.



Zoom tool
This tool changes the current view's scale and position so that you can zoom in to a part of 
an object or zoom out to view an entire scene. 
To zoom in to a particular portion of the view, click and drag a rectangle around the area you
want to see more closely. The center of the rectangle becomes the new view position, and 
the view changes to fit the contents of the rectangle onto the screen.
To zoom in to a particular point in a view, click that point with the zoom tool. The view is 
scaled by 400%.
Tool space: While you drag the zoom rectangle, the current zoom scale is displayed in the 
tool space. The value is expressed as the number of times that you want the view to 
increase or decrease in scale. To zoom in or zoom out by a factor, type a zoom factor into 
the tool space. For example, to double the current view scale, type 2.0 in the tool space. To 
zoom out by 50%, type 0.5 in the tool space.
 Modifier key: To zoom out, press the F3 key while zooming.



Working plane tool
The working plane is a surface in space that is the ground for drawing new objects. When 
you draw a new object, it is aligned with the current working plane. Like a drafting table, the 
working plane is flat, but it can be moved and rotated using the arrow tool. The surface of 
the working plane is a grid, the measurements of which are defined using the Rulers dialog 
box. The coordinates of this grid are used by several tools in the tool palette. 
To reorient the current working plane, choose Show Working Plane from the View menu if the
working plane is not currently visible. 
Using the working plane tool, follow this sequence: 
To define the origin of the working plane, click once in the workspace. 
To define the x-axis of the working plane, click a second time in the workspace. 
To define the y-axis of the working plane, click a third time on a point that's included in 
the plane. The surface defined by the three clicks is the new working plane.
Modifier key: To align the working plane with an object, press the o key while moving the 
working plane.



Paint bucket tool
With this tool, you can apply the current material to any object you select. For example, if 
you have created a material called aluminum," you can set selected objects to have those 
material properties.
To change an object's material, select the material in the Material Browser. Then, using the 
paint bucket tool, click the object whose material you want to change, or drag a selection 
rectangle around several objects. Any selected object takes on the new material properties.



Text tool
Use this tool to create characters and words that can be extruded or swept to form 3D 
objects. MacroModel extracts the font outlines from the letters. Once the letters have been 
created, you can edit them like any other spline object.
To create a line of text, click the point in the drawing space where you want to place the 
base of the first character. Type the text in the tool space. Press Return or Enter when you've
finished entering text.
Tool space: When the text tool is selected, the tool space displays the text you type.

Click for more information: Text Tool Preferences



Text Tool Preferences

Use the options in this dialog box to set the font and size of text. Open the dialog box by 
double-clicking the text tool in the tool palette.
In the Font drop-down list, you can choose from the installed fonts. 
The font Size numeric field uses the units that are set in the Rulers dialog box. Note that 
font size is expressed in ruler units, not in points. One inch equals 72 points. The default text
size is one inch tall. 



Construction geometry tool group
The tools in this group allow you to create construction geometry -- frameworks that provide 
visual references, like scaffolding for your model. Construction geometry remains on the 
screen and can be moved or rotated with the arrow tool like any other object. Nearby 2D and
3D objects can snap to construction geometry. To hide construction geometry, choose Hide 
Construction Geometry from the View menu. There are four types of construction geometry: 
construction points, construction lines, construction grids, and construction axes.
Click a tool to see information about it.



Construction point tool
This tool places a point, marked by an x, on the screen. When objects are moved near this 
point, the point is a snapping reference.
To place a construction point, click once in the workspace. You can move the construction 
point using the arrow tool.



Construction line tool
A construction line is a guideline on the screen that you can use as a visual or snapping 
reference.
To place a construction line, click once in the workspace to place the center of the line, then 
drag the line around its center point. By default, the line spans the width of the screen. You 
can move and rotate the construction line using the arrow tool.



Construction grid tool
Use this tool to create a plane with a 4x4 grid. The units on the grid are set in the Rulers 
dialog box. Each point and line on the grid can be snapped to, or can be used as a visual 
reference. You can move and rotate a construction grid using the arrow tool.
Center-corner toggle: When the corner toggle is set, you can draw the construction grid 
from the perimeter.
Tool space: When the construction grid tool is selected, the tool space displays the width 
and height of the construction grid. You can change the dimensions of the construction grid 
by tabbing to the numeric fields, typing new numbers, and pressing Enter or Return.
Modifier key: To create a grid along an object's surface, press the o key.



Construction axis tool
Use this tool to create a 3-axis construction object to align and orient objects.
To create a construction axis, click in the workspace to define the center of the construction 
axis. If an object is selected, the construction axis is oriented to it. If no object is selected, 
the construction axis is oriented to the world.



Circle tool group
Click a tool to see information about it.



Circle and ellipse tools
Use these tools to create 2D objects on the working plane. When you've made a circle or 
ellipse, you can extrude it to make a 3D object, or you can use other tools to make a 
compound 2D object.
To create a circle or ellipse, choose the circle or ellipse tool from the tool palette and click to 
define the object's center. Drag away from the center point to define the object's radius, or 
click twice to set the radius.
With the ellipse tool, you can independently control both the width and height in the tool 
space.
Tool space: When the circle tool is selected, the tool space displays the radius of the circle. 
To define a circle using the tool space, click once to define the center point, then type the 
radius in the tool space and press Enter or Return.
When the ellipse tool is selected, the tool space displays the width and height of the ellipse. 
To define an ellipse using the tool space, click once in the workspace to define the center 
point, then type the width and height in the tool space and press Enter or Return.
Center-corner toggle: With the corner toggle set, click the perimeter of the circle or 
ellipse and drag to the center.
Modifier key: To snap a circle or ellipse to surfaces or curves that are off the working plane,
press the 3 key while drawing.



Regular polygon tool
Use this tool to create regular polygons. To create a polygon, choose the polygon tool from 
the tool palette, then click to define the object's center. Drag away from the center to define 
the object's perimeter.
Tool space: The polygon's radius and number of sides are set in the tool space.
Center-corner toggle: When the corner toggle is set, you can draw the polygon from the 
perimeter to the center.



Line tool
Use this tool to draw a 2D line on the current working plane. You can extrude a line to form a
rectangle, or you can use it as a section in a piece of joined geometry.
Tool space: When the line tool is selected, the tool space displays editable fields for the 
length and angle of the line. Length is expressed in model units; angle is expressed in 
degrees counterclockwise from the horizontal on the current working plane. 
To define a line in the tool space, click to specify the starting point of the line, type the 
length and angle of the line, and press Enter or Return.
Modifier key: To snap a line to surfaces or curves that are off the working plane, pressing 
the 3 key while drawing.



Polyline tool
Use this tool to create open or closed 2D polygons. Closed polygons can be extruded to form
solid objects. Open polygons can be combined with other 2D shapes to create compound 
geometry.
To draw a polyline, click to define the starting point of the polyline, drag the cursor to the 
end point of the first line segment, and release the mouse button. Click and drag to form as 
many line segments as you want, then double-click to complete the polyline.
To create a closed polyline shape, complete the object by double-clicking the starting point.
Tool space: When the polyline tool is selected, you can type the length and angle of the 
next line segment. Length is expressed in inches; angle is expressed in degrees 
counterclockwise from the horizontal on the current working plane. 
Modifier key: To snap a polyline to surfaces or curves that are off the working plane, press 
the 3 key while drawing.



Arc tool group
Use these tools to create curved line segments on the current working plane. You can use 
these objects as part of compound 2D geometry or to create a path for a sweep object. 
Click a tool to see information about it.



Center arc tool
To create a center arc, click to define the center of the arc, then drag the radius. Click and 
drag again to define the included angle of the arc.
Tool space: When the center arc tool is selected, the tool space displays editable fields for 
the radius, the start angle, and the included angle of the arc. To define a center arc using the
tool space, click to specify the center point for the arc, type the starting angle and included 
angle, and press Return or Enter.



Tangent arc tool
To create a tangent arc, click to define the origin of the arc, then drag a line to which the arc 
will be tangent. Click and drag to define the arc's radius and included angle.



Rectangle tool group
This tool group includes the rectangle and square tools. Use these tools to create 2D 
geometry on the current working plane. When you've made a square or a rectangle, you can
extrude it to make it three dimensional, or use other geometry tools to make a compound 
2D object.
To make a square or a rectangle, click to define a center point for the object then drag the 
object's length away from the center point.
Tool space: When the rectangle tool is selected, the tool space displays editable fields for 
the width and height of the object.    When the square tool is selected, the tool space 
displays an editable field for the width of the object. 
Center-corner toggle: With the corner toggle set, click to define the starting corner of the 
object, drag to the opposite corner.
Modifier key: To snap rectangles and squares to surfaces or curves that are off the working 
plane, press the 3 key while drawing.



Spline tool
Use this tool to create open or closed 2D Bézier spline curves on the working plane. You can 
use a spline curve as part of compound 2D geometry, or you can use it to create a path for a
sweep object. 
To create a spline curve, you perform a series of clicks and drags. Click to define the starting 
point of the spline object, then drag to define the tangent point for the control point. 
Continue to click and drag to add new control points and direction lines to the spline curve. 
When you've completed the object, double-click.
Note: Double-clicking does not close the spline curve. To make a closed spline curve, place 
the curve's end point at the starting point.
Modifier keys: 
- To snap spline curves to surfaces or curves that are off the working plane, press the 3 

key while drawing.
- By pressing the F3 key while clicking a point, you can set the control line for the next 

point by dragging and releasing. This allows you to create a sharp control point or a 
shallow one.



Mirror tool group
The tools in this group allow you to create the mirror image of an object. 
Click a tool to see information about it.

Mirror Preferences

To make a duplicate of the selected object and mirror it, select Copy Mirrored Objects in the 
Mirror Tool Preferences dialog box. Open the dialog box by double-clicking the mirror tool.



Mirror 2D tool
To create a mirrored object, click the object that you want to mirror, then draw an axis on the
current working plane. The mirrored object is flipped across this axis.



Mirror 3D tool
Use this tool to create a mirror image of the selected object across an arbitrary plane. To 
mirror the selected object, click three times to define a mirror plane.



Geometry modifier tool group
This group contains tools for modifying 2D and 3D geometry.
Click a tool to see information about it.



Fillet tool
Use this tool to round the corners of polyline objects, rectangles, arcs, splines, and ellipses.
To fillet an object, click once on either side of the corner you want to round. By default, 
MacroModel fillets a .25-inch radius. To change the radius of a fillet, enter a new radius in the
tool space before clicking the corners of the object.
Tool space: When the fillet tool is selected, the tool space displays an editable field for the 
fillet radius.



Trim tool
Use this tool to remove a section of geometry, such as a line segment or a corner, from an 
object. You can then insert and join other geometry into this space to form compound 2D 
shapes.
To trim an object, click once to define the beginning of the segment to be removed. Click a 
second time to define the end of the segment to be removed. Click a third time to specify 
which side of the object to remove.
Note: All clicks must fall on lines within the same object.
Modifier key: To cut the object at the snap location, press the F3 key while clicking the first 
time. 



Offset tool
Use this tool to create an object whose vertexes are all the same distance from another 
object -- for example, concentric circles or thick walls. Use this tool to offset any 2D shape, 
whether it's closed or open.
To offset an object, click the 2D object and drag. As you drag away from the object's center, 
the offset object grows. Drag toward the object's center to make the offset smaller.
Tool space: When the offset tool is selected, the tool space displays an editable field for the
offset distance. To define the offset using the tool space, type the offset value and press 
Enter or Return.



Move object center tool
Use this tool to reposition an object's center pointthe point around which the object rotates, 
and the point to which the object's parent and children are aligned.
To reposition an object's center, click the object with the arrow tool to open it for editing. The
center of the object is displayed as a small green dot. Using the move object center tool, 
click and drag the object's center to reposition it.



Extrude tool group
These tools give height to a selected 2D object or set of 2D objects, thus making a three-
dimensional object. Using this tool, you can turn circles into cylinders and squares into 
cubes, for example.
Click a tool to see information about it.



Extrude tool
To extrude a 2D object or set of 2D objects, click the objects to be extruded. If the selected 
object contains other objects, they are extruded as holes. Click and drag the height that you 
want the 3D object to be. You can drag along any axis. MacroModel uses the length of the 
line, not its direction. 
Tool space: When the extrude tool is selected, the tool space displays an editable field for 
the extrude depth. To specify the height of the extruded object, type the height in the tool 
space and press Return or Enter.



Bevel tool
This tool creates an extruded object with beveled front and back caps. 
Bevel tool preferences
You can set the style of the bevel in the Bevel Tool Preferences dialog box. Open the dialog 
box by double-clicking the bevel tool in the tool palette.
The Bevel Front option applies a bevel to the front cap of the extruded shape. The Bevel 
Back option applies a bevel to the back of the extruded shape. The Hard Bevel option 
applies a chamfered bevel to the object; if this option is not checked, a curved bevel is 
applied.
Tool space: When the bevel tool is selected, the tool space displays editable fields for the 
extrude depth and bevel width. To specify these parameters, type numbers in the tool space 
and press Enter or Return.



Lathe tool
To lathe a 2D object, click the object to be lathed. If the selected object contains other 
objects, they are lathed as holes. Click and drag a line to define the axis around which the 
object will be lathed. 
Tool space: When the lathe tool is selected, the tool space displays an editable field for the 
lathe angle, expressed in degrees. By default, an object is lathed 360° around the specified 
axis. However, you can type any lathe angle in the tool space. If you want a half-lathe for 
example, type 180° in the tool space and press Enter or Return.



Sweep tool
This tool extends a 2D profile (the sweep profile) along a path (the sweep path) to create a 
3D sweep object. For example, sweeping a circle along a line produces a cylinder. However, 
sweeping a circle along a spline curve creates a segment of curved tubing, like a bent pipe.
To create sweep objects with interior cavities, select multiple sweep profiles.
To create a sweep object, select the sweep tool and click the 2D object (or shift-click to 
select multiple objects) that you want to specify as the sweep profile. Click a second time on
the 2D object that you want to specify as the sweep path. To begin the sweep, double-click 
the sweep path or press Enter. The profile is swept along the path. The sweep object retains 
the position and orientation of the original sweep profile.
Tool space: When the sweep tool is selected, the tool space displays editable fields for the 
beginning scale and ending scale of the sweep. This allows you to create a tapered sweep 
object.
Click for more information: Sweep tool preferences



Sweep Tool Preferences

Open the Sweep Tool Preferences dialog box by double-clicking the sweep tool in the tool 
palette.
The Number of Sections field controls the number of interior cross section for each 
segment of the sweep path. The higher the number of cross sections, the smoother the 
sweep object will appear. This is particularly useful when the sweep path makes steep or 
irregular turns. The default number of cross-sections is 1.
The Fix Path Location radio button fixes the position and orientation of the sweep path. 
When this option is selected, the sweep profile is swept along the fixed path.
The Fix Profile Location radio button also fixes the position and orientation of the sweep 
profile. When this option is selected, the swept object has the same position and orientation 
as the original profile.



Skin tool
Use this tool to create an object that wraps around the edges of existing objects. By skinning
two arcs, for example, you can make a hangar-like structure. You can skin a path, such as a 
spline, or closed shapes, such as rectangles.
To create a skinned object, click in order the objects to be skinnedthe skin profiles. When all 
the profiles are selected, double-click the workspace background or press Enter. 
Note: Skinned objects need not have the same number of vertexes or control points; 
MacroModel interpolates the shapes to form a smooth object.
Click for more information: Skin tool preferences



Skin tool preferences

Open the Skin Tool Preferences dialog box by double-clicking the skin tool in the tool palette.
The Linear Surface Between Profiles option creates a noncurved surface between the 
skin profiles. By default, this option is off, and a curved surface is created between skin 
profiles.
The Auto Profile Direction option reconciles the order of the points along the skin profile. 
For example, when this option is selected and one skin profile is created from top to bottom 
and another is created from bottom to top, MacroModel reconciles them so that the points 
go in the same direction. When this option is not selected, MacroModel skins the profiles in 
the order that the points on the skin profiles were created.



Deformation tool group
The tools in this group twist, bend, taper, and stretch objects.
Click a tool to see information about it.

Click for more information: Deformation Tool Preferences



Deformation tool preferences

The Deformation Tool Preferences dialog box allows you to set the axis along which the tool 
deforms the selected object. 
Open the dialog box by double-clicking the desired tool in the tool palette.
By selecting the options in this dialog box, you can set the tool to deform the object along its
x-axis, y-axis, or z-axis. By default, the tool deforms the object around the object's z-axis. By
selecting the Deform along Working Plane's z axis, you can set the tool to deform the object 
along the z-axis of the working plane, rather than along the object coordinates.



Twist tool
This tool twists the selected object around the object's axis, as defined in the Deformation 
Tool Preferences dialog box. By default, the object is twisted around its z axis.
Tool space: When this tool is selected, the tool space displays an editable field for the angle
of the twist, expressed in degrees of counterclockwise twist.
Using this tool, you can apply a twist over the entire length of the object -- an unanchored 
twist. Or you can anchor the twist on a point on the object -- an anchored twist.
Modifier key: By pressing the F3 key, you can select an anchor point around which to twist 
the object.
To twist an object, follow this sequence:
To select an object to twist, click the object with the twist tool.
The twist is applied over the entire length of the object.
To define an anchored twist (optional), press the F3 key and click an anchor point on the 
object. Click again to define a range over which to twist the object. Drag to indicate the 
amount of twist.



Bend tool
This tool bends the selected object around the object's axis, as defined in the Deformation 
Tool Preferences dialog box. By default, the object is bent around its z-axis.
Tool space: When this tool is selected, the tool space displays an editable field for the bend
angle, expressed in degrees of counterclockwise bend.
Using this tool you can apply a bend over the entire length of the object -- an unanchored 
bend. Or, you can anchor the bend on a point on the object -- an anchored bend.    
Modifier key: By pressing the F3 key, you can select an anchor point from which to bend 
the object.
To bend an object, follow this sequence:
To select an object to bend, click the object with the bend tool.
The bend is applied over the entire length of the object.
To define an anchored bend (optional), press the F3 key and click an anchor point on the 
object. Click again to define a range over which to bend the object. Drag to indicate the 
amount of bend. 



Taper tool
This tool tapers the selected object along the object's axis, as defined in the Deformation 
Tool Preferences dialog box. By default, the object is tapered along its z-axis.
Tool space: When this tool is selected, the tool space displays an editable field for the 
amount of taper, expressed as a percentage. 
Using this tool, you can apply a taper over the entire length of the object -- an unanchored 
taper. Or you can anchor the taper on a point on the object -- an anchored taper. In an 
anchored bend, the object is tapered.
Modifier key: By pressing the F3 key, you can select an anchor point from which to taper 
the object.
To taper an object, follow this sequence:
To select an object to taper, click the object with the taper tool.
The taper is applied over the entire length of the object.
To define an anchored taper (optional), press the F3 key and click an anchor point on the 
object. Click again to define a range over which to taper the object. Drag to indicate the 
amount of taper. 



Stretch tool
This tool stretches the selected object along the object's axis, as defined in the Deformation 
Tool Preferences dialog box. By default, the object is stretched along its z-axis.
Tool space: When this tool is selected, the tool space displays an editable field for the 
amount of stretch, expressed as a percentage. 
Using this tool, you can apply a stretch over the entire length of the object -- an unanchored 
stretch. Or, you can anchor the stretch on a point on the object -- an anchored stretch. 
Modifier key: By pressing the F3 key, you can select an anchor point from which to stretch 
the object.
To stretch an object, follow this sequence:
To select an object to stretch, click the object with the stretch tool.
The stretch is applied over the entire length of the object.
To define an anchored stretch (optional), press the F3 key and click an anchor point on the 
object. Click again to define a range over which to stretch the object. Drag to indicate the 
amount of stretch. 



Cross-section tool
Use this tool to create 3D objects from a 2D front profile, side profile, and cross-section. You 
create the profiles and cross section using any of the 2D MacroModel tools.
The first 2D object you click becomes the object's cross section. The second object clicked 
becomes the front profile. The third object clicked becomes the side profile. After the cross 
section and profiles are defined, press Enter to build the 3D object.
When building the 3D object, MacroModel attempts to find a correspondence between 
control points on the front and side profiles, and then generates a surface that comes as 
close as possible to the shape of the cross section. This works best when the front and side 
profiles have the same number of control points. An easy way to give both profiles the same 
number of control points is to copy both profiles from the same shape and then transform 
each shape as needed without removing or deleting points.
Modifier keys: By pressing the F3 key and clicking, you can define the axis for the cross 
section or front profile.



Center-corner toggle
The center-corner toggle tool modifies how several tools operate. When the center toggle is 
set, you can use the selected tool to draw an object from the center to the perimeter. When 
the corner toggle is set, the tool draws the object from the perimeter to the center.
When the operation of a tool can be modified using the center-corner toggle, that is noted in 
the description of the tool in these help screens.




